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ABSTRACT 
The goal of this project was to study the effects of germinants L-alanine and inosine on 

the morphology of Bacillus anthracis spores in vitro using atomic force microscopy (AFM) 

and phase contrast microscopy. Spores were incubated for four hours with germinants, 

deposited on mica, dried, and imaged in air. Spores exposed to inosine, L-alanine, and a 

combination of both germinants swelled to 2.0, 6.0, and 2.5 times the size (area) of the 

control spores respectively. However, only the sample that was exposed to both germinants 

entered phase-1 germination, turning phase-dark as studied by phase contrast microscopy. 

Bumps and ridges on the spore surfaces became far less prevalent and prominent in samples 

exposed to germinants. 
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1. INTRODUCTION 
Bacillus anthracis is the endospore-forming, etiological agent of the famous and deadly 

disease Anthrax. It is well known for its role in the 2001 terrorist attacks on the United States 

Postal Service distribution centers where 22 were infected (Fennelly, Davidow, Miller, 

Connell, & Ellner, 2004); however, B. anthracis is a naturally occurring microorganism and 

has a history of infecting and killing humans through more natural means as well. Humans 

may become infected by consuming undercooked meats of infected animals or through 

handling hair or hide of infected animals. Infections vary by type of exposure and include 

cutaneous, gastro-intestinal, and inhalational Anthrax. Inhalational Anthrax, which is caused 

by inhaling B. anthracis spores, is the target infection of terrorist attacks and results in nearly 

100% mortality if the infection if left untreated (Centers for Disease Control and Prevention, 

2001).  

Besides B. anthracis, endospore-forming pathogens, including but not limited to Bacillus 

and Clostridium spores, threaten food safety in industrial and residential environments 

because of their resistance to high temperatures and chemicals and ability to adhere to 

surfaces such as pipes and containers. Clostridum perfringens will flourish in insufficiently 

cooled and heated food and can produce more than enough toxin necessary to give a person 

food poisoning. Bacillus cereus, a bacteria found in the guts of cows as well as in soil, is 

prevalent in cow’s milk because of soiling of the udders, is extremely difficult to remove 

through pasteurization, and is capable or growing in temperature as low as 4ºC (Andersson, 

Ronner, & Granum, 1995). Knowledge of endospore morphology and behavior may yield 

new technologies that will protect public health and safety. 

Prior studies have investigated the morphological changes of germinating Bacillus 

atrophaeus, Bacillus anthracis sterne, and Bacillus subtilis using atomic force microscopy 

(Chada, Sanstad, Wang, & Driks, 2003) (Plomp, Leighton, Wheeler, Hill, & Malkin, 2007) 

(Zaman, et al., 2005). They provide a preliminary understanding of Bacillus spore 

morphology and how Bacillus spore coats are shed during germination. This study is the first 

to compare spore morphologies under several germinant conditions using atomic force 
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microscopy and is an early step in understanding the mechanisms of spore germination. It 

also investigates whether germination proceeds more quickly in the presence of two 

germinants than in the presence of one. Knowledge of these mechanisms is critical to 

developing sanitation, disease control, and cell development theory. 
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2. BACKGROUND 

2.1. GENUS BACILLUS 

The genus Bacillus is a group of Gram-positive, endospore-forming, aerobic bacteria. 

The organisms within this genus vary widely in physiology, but all have the common ability 

to form protective spore coats and exosporium during periods when available nutrients are 

insufficient for growth and reproduction (Todar, 2004). Bacillus spores are able to survive 

extreme temperatures and harsh chemical environments for long periods (Gould, 1977). 

2.1.1. SIGNIFICANCE 

Bacillus anthracis, the causative bacteria of Anthrax, and Bacillus cereus, a common 

suspect for food poisoning, are the most medically important species. B. anthracis was the 

first microorganism proven to cause a specific human disease. Many other Bacillus species 

are being found to be prevalent human pathogens (Todar, 2004).  

 Despite their negative reputation as pathogens of insects, animals, and humans, Bacillus 

bacteria play an important environmental role. They are considered “normal flora” of soil and 

thought to be important players in degradation of biopolymers and Earth’s nitrogen and 

carbon cycles. (Todar, 2004). 

2.1.2. SPORE MORPHOLOGIES 

B. anthracis spores can range in size from spherical cells approximately 0.8-0.9 µm in 

diameter (Zaman, et al., 2005) to elongated spores approximately 1.35 µm long and 0.75 µm 

wide (Chada, Sanstad, Wang, & Driks, 2003). Chada classified the elongated spores into two 

separate groups. The slightly smaller spores, measuring approximately 1.27 µm long and 

0.74 µm wide, do not posses ridges and instead have bumps ranging between 8 and 40 nm in 

diameter. The larger spores, measuring approximately 1.47 µm long and 0.76 µm wide, have 

bumps and ridges. It is believed that the smaller group of spore still possessed their 

exosporium (Wang, Krishnamurthy, Jeong, Driks, Mehta, & Gingras, 2007), while the larger 

ridged spores had lost their exosporium “during culturing or preparation for AFM analysis” 
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(Chada, Sanstad, Wang, & Driks, 2003). The shed exosporium often appears as thin films 

adhered to the imaging surface surrounding spores in atomic force microscopy images 

(Plomp, Leighton, Wheeler, & Malkin, 2005), as shown in Figure 1. It is unknown why 

Chada had not seen spherical cells in his studies or why Zaman did not mention the visible 

elongated cell in Figure 1(a) in his paper. 

 

FIGURE 1 – AFM IMAGE OF BACILLUS ATROPHAEUS EXOSPORIUM LABELED "E" (PLOMP, LEIGHTON, 

WHEELER, & MALKIN, 2005) 

2.1.3. GERMINATION 

When nutrient-rich conditions return to the Bacillus spores, they lose their protective 

exosporium and spore coats and thus become vulnerable to their environment. The cells must 

be sure that the environmental conditions are conducive to growth and reproduction before 

they germinate. The signals that trigger this response are small molecules and ions called 

germinants. These various germinants can signal Bacillus cells, without any other 

environmental inputs, to germinate out of their dormancy and into a vegetative state 

(Paidhungat & Setlow, 1999). 

sporulation in these three species of Bacillus spores. How-
ever, rodlets do not nucleate and grow on the outer coat of
B. thuringiensis spores. Under different physiological con-
ditions, it is possible that rodlets could assemble on the
B. thuringiensis spore surface.
The striking differences in native rodlet motifs seen in

B. atrophaeus (one major domain for each spore), B. cereus
(a patchy multidomain motif), and B. thuringiensis (extra-
sporal rodlets) appear to be a consequence of species-specific
nucleation and crystallization mechanisms which regulate
the assembly of the outer spore coat. The control of rodlet
crystallization could depend on morphogenetic assembly
factors, composition and concentration of the growth units,
as well as on environmental factors, such as temperature,
pH, metals, and salts. In the case of B. cereus outer coat
assembly, the surface free energy (Chernov, 1984) for crys-
talline phase nucleation appears to be low enough to allow
the formation of multiple rodlet domains resulting in cross-
patched and layered assemblies. During the assembly of the
outer coat of B. atrophaeus spores, the surface free energy
may be considerably higher; reducing nucleation to the point

that only one major domain is formed covering the entire
spore surface.
All Bacillus species investigated utilize very similar

rodlet structures as spore coat building blocks. The mech-
anisms of self-assembly of spore coat structural layers
appear to be closely related to those described for crystal-
lization of inorganic single crystals (Chernov, 1984) and
macromolecular crystals grown for x-ray diffraction
analysis (McPherson, 1999; Vekilov and Chernov, 2002).
Consequently, fundamental and applied concepts devel-
oped for the growth of inorganic and protein crystals can
be successfully applied to study the assembly of the spore
coat. The solution chemistry (i.e., concentration of assem-
bly factors, spore coat proteins, small molecules, pH,
temperature, etc.) during spore integument formation may
control the macromolecular arrangement of rodlet motifs.
Indeed, it has been reported that the addition of Na2SO3

during sporulation of B. cereus caused rodlet elongation
and incomplete rodlet layer assembly (Aronson and
Fitz-James, 1976). These observations suggest that spore
coat architecture and topology are genetically and

FIGURE 1 The spore coats of B.
thuringiensis (a–c), B. cereus (d–f),
and B. atrophaeus (g and h) consist of
crystalline layers of honeycomb and

rodlet structures. B. thuringiensis (a)
and B. cereus (d) spores are surrounded
by an exosporium (E), which collapses

and adheres to the substrate when
spores are air-dried. The exosporium

(b) is 25–40-nm thick and has a;3-nm

thick and 20–30-nm wide footstep (F)
with numerous thin (;1 nm) and short
(50–60 nm) hair-like appendages (A2)
attached to it. Additionally, there are

typically 4–8 tubular appendages (A1)
attached to the exosporium with diam-
eters and lengths of 3–12 nm and 300–

1200 nm, respectively. Underneath the

exosporium, a honeycomb crystalline
layer defines the outer surface of B.
thuringiensis spores (c). This honey-

comb layer is formed by domains with

random crystalline orientations that are
separated by linear defects. In e and h,
the crystalline rodlet structures of B.
cereus and B. atrophaeus spore coats

are shown. B. cereus spores contain
a crystalline honeycomb structure (f)
beneath the exterior rodlet layer. B.
thuringiensis spore coats do not contain
rodlet structures. Rodlet assemblies can
be seen adsorbed to the substrate (i).
Scale bar, 500 nm in a, d, and g; 50 nm
in b, c, e, f, h, and i.

Structure and Dynamics of Spores 605

Biophysical Journal 88(1) 603–608
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Early spore germination is considered a strictly biophysical process because spores have 

no metabolism or mass transfer during their dormancy. Germination is carried out by 

enzymatic processes that first degrade the spore coat. The inner germinant receptors are then 

exposed and activated, restarting the cell metabolism. Germination occurring without 

enzymatic germinants proceeds slowly in comparison (Moir A. , 2006). Based on an isobaric 

protein tagging system carried out at the University of Michigan, degradation of several outer 

protein layers of Bacillus anthracis occurred within 17 minutes of initial exposure to Difco 

Sporulation Media, which contains enzymatic germinants. During this period the cells were 

still in a dormant state and had not restarted their metabolic processes. Within the next 20 

minutes, cells showed a modest increase in proteins known to be involved in key metabolic 

processes (Jagtap, et al., 2006). It is expected that germination would occur quickly since 

rapid outgrowth would help the cells compete with other species in environments where 

nutrients come and go quickly. 

Marco Plomp, an experienced researcher of Bacillus spore germination, most recently 

released high-resolution atomic force microscope images of the germination of Bacillus 

atrophaeus using 100 mM L-alanine, 1.65 mM L-Asparagine, 2.8 mM D-Glucose, 2.8 mM 

D-Fructose, 5 mM potassium chloride, and 25 mM Tris HCl buffer pH 8.0. These images 

revealed de-evolution of B. atrophaeus’s complex rodlet spore coat layer. He found that 

within 13 minutes, “etch pits” as deep as 70 nm were formed. These pits initiated larger 

fissures that formed perpendicular to the organized rodlet layer and expanded in both axes as 

the vegetative cell emerged. The fissures expanded more rapidly around imperfect stacking 

faults of the rodlet structure. The first signs of expansion appeared at 5:45 (in hr:min). 

Vegetative cell emergence did not occur until after the 8 hour imaging period. Plomp also 

found that in his studied conditions spores turned phase-dark after just 15 minutes, which 

corresponded to the initiation of phase-1 germination (Plomp, Leighton, Wheeler, Hill, & 

Malkin, 2007).  

Esterase activity (EA) may provide a benchmark for measuring germination of Bacillus 

spores because EA is associated with activation of proteases and cortexlytic enzymes, which 

are essential to early stage, Phase-1 (pre-metabolism) germination. The EA for B. anthracis 



6 

 

after exposure to both L-alanine and inosine is 100 times larger than the EA with either sole 

germinant (Ferencko, Cote, & Rotmana, 2004). This raises the question of whether the 

combination of these germinants accelerates the germination process. 

2.2. ATOMIC FORCE MICROSCOPY 

2.2.1. FUNDAMENTALS 

Atomic force microscopy is rather different than traditional imaging technologies. Instead 

of measuring light, directly by the operator’s eye or by a photodiode, an AFM measures a 

surface by touch. The modern tip that is used as a measurement device is a silicon chip with 

an attached thin, flexible microcantilever. On the end of this cantilever is a tip that can range 

from a 1 um or larger tip, which is typically used for force measurements, to a thin carbon 

nanotube, which provides high-resolution images. 

During imaging a laser is shone onto the cantilever where it is reflected onto a 

photodiode. After proper calibration, the relative position of the cantilever correlates to the 

laser position on the photodiode. Normal vertical deflection of the cantilever translates into a 

vertical deflection of the laser onto the receiving photodiode, while torsional cantilever 

deflection translates into horizontal laser deflection. These two datum are combined to give 

three dimensional topography of the sample. 

Three modes exist for measuring samples. In contact mode, the cantilever force sensor is 

placed on the sample and dragged across the surface. This method provides topographical 

data only, and is slightly less accurate than the second and third method, tapping and non-

contact modes. 

In tapping mode, the cantilever is directly vibrated using a small electrostatic device at 

the cantilever’s resonance frequency and the desired drive amplitude. The cantilever is 

brought to immediately above the sample where it is scanned across the surface. The tip of 

the cantilever gently taps the surface at the bottom of each phase of the tip’s vibrations, 

thereby changing the amplitude and phase of the cantilever vibration. As the tip scans the 

surface, the height of the tip is adjusted using a piezoelectric element to keep the amplitude 
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of the cantilever at the desired amplitude set-point. Proper control of the cantilever height is 

achieved using a feedback loop with proportional and integral corrections.   

Tapping mode is gentler on the sample because there is much less direct contact between 

the tip and the sample, however and even more gentle method exists. In non-contact mode 

the cantilever is also vibrated much like in tapping mode; however, during non-contact mode, 

the amplitude of the cantilever is made small enough that it can measure the strong repulsive 

and attractive intermolecular forces between the cantilever tip and sample. In this mode the 

topography of the sample may be taken without disturbing the surface of the sample since it 

does not rely on contact between the tip and sample. 

 Three images may be derived from tapping mode, the mode used in this study. The first 

is a height image, or a topographical image. The second is a map of the force applied to the 

cantilever tip each time it contacts the surface of the sample, which is calculated using the 

amplitude data. The third image represents the difference between the phase of driving 

element and the phase of the cantilever. Only height images may be used for quantitative 

analysis. Amplitude and phase images may only be used for qualitative analysis because they 

contain no direct measurements of the surface topography. 
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3. METHODOLOGY  
Four groups of B. anthracis were examined using atomic force spectroscopy and phase 

contrast microscopy after incubation in the following conditions: 

TABLE 1 - GERMINANT CONDITIONS 

  L-Alanine  Inosine  Tris-Hcl pH 7.0  
Control  0 0 0 
Sample 1  50.0mM 0 25.0mM 
Sample 2  0 5.0mM 10.0mM 
Sample 3  50.0mM 5.0mM 17.5mM 

 

The following flow chart (Figure 2) shows the steps taken during this study: 

 

FIGURE 2 – METHODOLOGY FLOW CHART 

Sample Preparation 

Atomic Force Microscopy 

Quantitative 
Measurements – 
Dimensions, 
Roughness 

Qualitative Analysis 
– Amplitude and 
Phase Images 

Phase Contrast 
Microscopy 

Phase‐Dark Count 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3.1. SAMPLE PREPARATION 

For each sample, stock B. anthracis was combined with the germinant solutions in a 

micro-centrifuge tube. Samples with germinants were incubated for 4 hours at 37 °C while 

being inverted at 40 rpm. The cells were spun down at 5000 rpm for 4 minutes and washed 

with double-distilled water three times. They were then re-suspended in the original volume 

of water. All samples were then sonicated for 10 minutes in a Branson 1510 sonicator.  Two 

ten µL volumes of each suspension were transferred to two separate slides of freshly cleaved 

mica taped to glass slides. One slide was left to settle for 10 minutes and then briefly (3 

seconds) rinsed with double-distilled water. Both slides were then left to dry for at least 24 

hours. The rinsed slide aided in imaging single, lone cells. 

3.2. ATOMIC FORCE MICROSCOPY 

The atomic force microscope used for these images was a Veeco (Digital Instruments) 

Dimension 3100. A Digital Instruments isolation barrier was also installed around the AFM. 

Tips used were MikroMasch Ultrasharp NSC15/AIBS, a single-cantilever, general-use tip. 

The air in the instrument room was kept below 15% relative humidity. 

3.2.1. SET-UP 

Overall, set-up and operation of the AFM was fairly simple; however, adjusting and 

tuning the AFM was critical in obtaining accurate, detailed images. An AFM tip was 

installed on a dry, clean tip holder, and the tip holder was installed onto the AFM laser. The 

laser unit was removed from its cradle and turned so the laser cast onto a surface. The laser 

was aligned onto the cantilever by first turning the right knob on the top of the laser 

clockwise until the laser spot vanished from the surface, and then slowly turned back to 

counterclockwise until the spot was fully visible again. This adjustment aligned the laser 

horizontally on the tip; the disappearance of the spot corresponded to the tip body obstructing 

the laser. Next the cantilever was aligned vertically using the top left knob. The knob was 

adjusted until the dot suddenly disappeared and then reappeared. This behavior corresponds 
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to the laser hitting and reflecting off of the thin cantilever for an instant as the laser passed 

over it. If the laser spot gradually disappeared, it meant that the tip was installed crooked and 

required adjustment. Once the cantilever was found, the laser was adjusted to reflect off of 

the vertical center of the cantilever to obtain maximum ‘sum’ as seen on the computer and 

then adjusted horizontally to obtain the maximum ‘sum’ while still casting close to the end of 

the cantilever. The laser unit was then reinstalled and locked into the AFM. 

The next step was to adjust the photodiode to center the laser upon it. This was 

accomplished by adjusting the knobs on the left side of the laser. The upper knob moved the 

laser on the x-axis and the lower knob moved the laser on the y-axis. First, the laser dot on 

the laser objective was moved to the rough center of the window. Finally, the computer 

objective was observed to finely tune the photodiode. The final desired outcome was to have 

a dot touching the crosshairs of the computer objective and have a deflection less than 1.0. 

At this point the AFM was ready for calibration of the cantilever resonance. This step 

was completed before any of the proceeding steps because resonance was often not 

acceptable and the only way to adjust the resonance properties of the cantilever was to move 

slightly the tip body in the tip holder, thereby undoing all laser and photodiode alignment. To 

begin oscillations, ‘Z modulation’, ‘amplitude setpoint’, and ‘drive amplitude’ were set to 1, 

2 V, and 300 mV respectively. The tuning fork icon was selected to begin tuning. A new 

window opened, which displayed drive settings and a chart of the resonance amplitude versus 

the resonance frequency. To achieve this data, the controllers completed ‘sweeps’ of 

frequencies within the specified sweep range. The easiest method for calibration was to set 

the ‘peak offset’ to 10 percent, set the ‘sweep range’ from about half the tip-manufacturer’s 

resonance specification to about twice the value, and then by click auto-tune function. After a 

successful automatic tune (where an obvious lone, offset peak was observed) the amplitude 

setpoint was adjusted to 2.0 V and drive amplitude was increased until the maximum 

amplitude value reached to at least half the height of the graph. The maximum acceptable 

drive amplitude was 600 mV. If this value was reached before the amplitude reached half the 

height of the graph, the laser was inverted, tip holder removed, and tip slightly adjusted in the 

tip holder. Even small adjustments of the tip would result in better (or worse) cantilever 
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resonance. Re-centering of the laser and photo-diode were required after any adjustment to 

the tip. 

If quality phase images were desired, it was important to NOT change the phase after 

auto-tune was performed. The program tunes the phase of the cantilever before it offsets the 

peak. This method provided very good quality phase images. 

After the cantilever was tuned, the AFM optics were centered and focused onto the 

cantilever. The ‘Locate Tip’ button (magnifying glass with yellow tip) was first pressed to 

focus on the cantilever. A window with a real-time microscope image appeared. Using this 

image as a guide, the focus was adjusted using the track ball and the pan was adjusted using 

the two knobs on the AFM optics. The desired outcome was to have the cantilever in focus 

with the crosshairs centered at the approximate location of the tip. 

After adjusting the optics, the cantilever was lowered to the surface of the sample and 

engaged. This was done by first focusing the optics on the surface by lowering the cantilever 

using the ‘Focus Surface’ button. When the small white dots of the cells were visible but not 

quite in focus, the ‘Focus Surface’ window was exited. The scan size was set to a value 

between 2.5 and 10.0 um and the tip was engaged using the ‘engage’ command. The tip first 

jumped down to the start position and then was incrementally lowered. During lowering the 

z-value on the very bottom of the screen was watched. If this value did not increase before 

engaging, it was considered a false engage. Rarely a false engage, caused by high humidity 

or controller error, was fixed by simply disengaging the surface and re-engaging. 

3.2.2. IMAGE TUNING 

Typically after engaging the surface, the computer increased the amplitude set-point to 

the point that it would disengage the surface. It was therefore necessary to reduce the 

amplitude set-point back to a value of 2.0. This was usually enough the re-engage the 

surface; however, if the tip had still not re-engaged the surface (the tip position read 

‘retracted’), then the drive amplitude was slowly increased until the tip tracked the surface 

accurately. 
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The image size was then adjusted to 20 µm. X- and Y- axis were varied to scan along the 

surface of the sample until an object with a height of at least 0.3 µm was found. The object 

was then centered in the scope and the image size was decreased to 10 µm, 5 µm, and then 

2.5 µm. The image was then tuned by adjusting the proportional and integral gains. 

Proportional gains had the smaller effect on image quality, but if too high, the proportional 

gain would cause low frequency noise in the image. Typical proportional gains ranged from 

1.2 to 2.0. The integral gain was first increased until high frequency noise was obvious, and 

then decreased until little noise was apparent. Since high control-loop gains provided more 

accurate tracking of the tip and higher quality amplitude and phase images, an image with a 

little edge noise was deemed acceptable. It was not a goal to completely eliminate noise, 

since noise at the edges of the cells could only be eliminated with an accompanying 

reduction in image quality caused by less accurate tracking. 

Images were captured at 1.0 Hertz, 512 points, and 512 lines. A variety of scan sizes were 

used to provide images for size and image calculations as well as qualitative analysis. 

3.2.3. IMAGE ANALYSIS 

The goal of image analysis was to measure cell length, width, height, and roughness for 

each condition. Qualitative observations were also made using the amplitude and phase 

images. 

Height images were first selected using the ‘Image’ pull-down menu and selecting either 

‘Select First Image’ or ‘Select Left Image’. After an image was selected, ‘Analyze’ and 

‘Modify’ pull-down menus appeared. The image was flattened using the ‘Plane Fit Auto’ tool 

under the ‘Modify’ menu’. This function was used rather than the ‘Flatten’ tool because 

‘Plane Fit Auto’ has the ability to adjust the entire image based on a correction derived from 

sections of the mica surface. In contrast, ‘Flatten’ looks at each data line individually and 

adjusts the tilt and height accordingly. ‘Flatten’ does not differentiate between cell and mica, 

which leads to incorrect correction and the formation artifact image structures. 

To flatten the image the ‘Plane Fit Auto’ option was selected under the ‘Modify’ menu. 

After the dialog box appeared, section of bare mica were selected on the image by simply 
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clicking on the image and dragging the box to the correct size. A relatively small area if mica 

is required to flatten the image correctly, but in general several large areas were selected to 

guarantee an accurate correction. After the areas were selected, the ‘XY’ button in the dialog 

box was pressed to indicate that box x- and y-axis image corrections were required. 

‘Execute’ was then pressed to complete the process and flatten the image. 

Once the image was corrected for tilt and bow, cell measurements were taken. Cells were 

measured using the ‘Section’ tool under the ‘Analyze’ pull-down menu. The length of a cell 

was measured by drawing a bisecting line through the longest length of the cell. Lines were 

drawn by clicking once to initiate a line and then clicking a second time to terminate the line. 

After the line was drawn, a box appeared prompting the user to mark two locations with red 

arrows. The program used these two points to measure length, height differences, and several 

other parameters. To measure length or width the red flags were placed at the local minimum 

of the edges of the cell. Width was always measured using a line perpendicular to the original 

length line. Height was measured by drawing a line that bisects the approximate highest point 

on a cell and any patch of bare mica. One marker was placed on the maximum height of the 

cell and the second on bare mica. For cells that had obvious edge artifacts caused by very 

abrupt height differences, the edge markers were placed at the approximate edge of the cell, 

guided by the visual image on the screen, rather than the absolute end of the cell. This 

method allowed for better comparison of cells that were grouped together and had no abrupt 

height changes to lone cells that displayed some image artifacts. 

Once the cells’ dimensions were recorded, the root mean square (RMS) roughness of the 

cells was measured using the ‘Roughness’ tool in the ‘Analyze’ pull-down menu. No matter 

the image scan size, a 371 nm by 371 nm box was drawn on the cell near the area of 

maximum height. Sometimes multiple, non-overlapping reading were taken if cells were 

large and relatively flat and then averaged. Measurements were never taken near cell edges 

because the RMS roughness calculation method is a height-difference calculation. Measuring 

on an edge would misrepresent the actual roughness. 
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3.3. PHASE CONTRAST MICROSCOPY 

Phase contrast microscopy was the benchmark for determining the extent of germination 

of each B. anthracis sample. A Nikon Eclipse E400 phase contrast microscope was used with 

a 100x/1.30 Nikon Plan Flour oil immersion objective and a PH3 light filter. Images were 

acquired from the microscope using a Diagnostic Instruments Insight camera and the 

SPOTSoftware Advanced imaging application. All samples were prepared and imaged side-

by-side to decrease variability. For this experiment, the control population was incubated in 

50mM Tris-HCL alongside the other samples. This is an improvement over the control used 

for AFM because it decreased the variability between samples. 

3.3.1. SLIDE PREPARATION 

Ten µL of suspended, prepared sample from each condition was placed on a clean glass 

slide and topped with a cover slide. Samples were allowed to settle for at least 10 minutes to 

increase adherence of cells to the glass and reduce water movement during imaging. 

3.3.2. PHASE CONTRAST IMAGING 

One drop of oil was place on top of the cover slide. After image was visually acquired 

and focused, it was captured using SPOT advanced. The program’s capture settings were set 

at gamma 1.0 and brightness 0.92. 
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4. RESULTS AND ANALYSIS 
Data on cell length, width, height, and RMS roughness obtained via atomic force 

microscopy and images obtained via phase contrast microscopy were the two means for 

analysis in this study. 

4.1. CONTROL SPORE SIZE 

The first control image taken, as seen in Figure 3, was ideal for comparing our research 

specimen to Chada, Zaman, and Wang’s specimens, which were reviewed in 2.1.2. 

 

 

FIGURE 3 – AFM PHASE IMAGE 001, CONTROL 10µM SCAN SIZE 
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FIGURE 4 – CONTROL IMAGE 001, SPORE HEIGHT VS. LENGTH 

In Figure 4, the heights of the cells were graphed against their rectangular areas (length 

times width). In this graph it is apparent that three separate groups of cells exist, being 

spherical, small elongated, and large elongated. This supports the findings of Zaman, who 

imaged spherical cells, and Chada who imaged elongated cells. Furthermore, Chada and 

Wang’s hypotheses regarding exosporium and cell ridges are supported by the phase image 

in Figure 3. It is clear that the largest elongated cells, those that are predicted to have 

completely lost their exosporium, have large defined ridges; the medium sized elongated 

cells have bumps and small ridges; and the small spherical cells have smooth surfaces. It is 

important to realize that these ‘roughness’ observations are based on qualitative analysis of a 

phase image and not measurements of RMS roughness or ridge size based on height data, 

which is explained in section 4.3. 
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4.2. MORPHOLOGICAL CHANGES TO GERMINATION 

Figure 5 represents the size of all measureable cells imaged during this study. 

 

FIGURE 5 - B. ANTHRACIS LENGTH VS WIDTH 

The red line in Figure 5 separates the spherical from the elongated spores. Notice that no 

elongated inosine spores were imaged. This does not mean that there were no elongated cells 

present. Elongated inosine spores were observed during phase contrast microscopy, which is 
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described later in section 4.3. It seemed during these experiments that the spherical cells were 

more common in the inner regions of the dried sample droplet and the elongated cells were 

more common on the outer regions. This may have to do with the difference in 

hydrophobicity based on the existence of the exosporium. It was not an objective to image 

both circular and elongated cells equally. 

By separating the data into these two categories we may accurately measure the swelling 

of spores as they germinate. Figure 6 shows the range and average cell area for each spore 

subgroup. 

 

FIGURE 6 – AVERAGE AND RANCHE CELL AREA PER SPORE SUBGROUP 

This data suggests that at least in the case of inosine and L-alanine, exposing spores to 

two germinants does not necessarily increase degradation of the spore coat, which 

corresponds to cell swelling. It is possible that spore became more swollen under exposure to 
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L-alanine alone than under exposure to both germinants because of some receptor site 

interference. 

4.3. CELL ROUGHNESS 

Two methods were used to evaluate cell roughness. The first was a quantitative method 

using and RMS roughness calculator on the NanoScope software. For each cell a 

0.371x0.371 µm square section was selected on the height image of the cell. This area was 

never selected over an edge, noise, or any image artifact to ensure an accurate roughness 

measurement. The results are summarized below in Figure 7. 

 

FIGURE 7 – AVERAGE AND RANGE CELL RMS ROUGHNESS PER SPORE SUBGROUP 
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Roughness measurements varied greatly throughout individual cells because of surface 

features like bumps and ridges. The average roughness of the control cells was higher than 

those of the germinant conditions but also had a very large range of roughness. Since far 

fewer L-alanine and L-alanine+inosine cells were imaged, it is quite possible that the 

narrower range of these groups was caused by a smaller sample. Overall, the quantitative 

roughness results were inconclusive. The surface roughness measured at this resolution is 

highly dependent on humidity, tip tracking, and AFM tuning. 

The second method for analysis is a qualitative analysis based on the AFM phase images. 

The apparent surface structures of the cells were highly variable. Cells were often smooth, 

bumpy, ridged, and even highly wrinkled. The images in Figure 8 are a good representation 

of the surface structures of each sample. These images have been adjusted so that they 

represent equal scale. All cells in these images, except the right cell in the control image, are 

spherical cells, so the size difference between each sample may also be visually compared. 
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FIGURE 8 – SPORE COAT SURFACE STRUCTURE COMPARISON 

You can see the bumpy and ridged structures in the two control spores. Smooth spherical 

cells were also found in the control as can be seen in Figure 3 or Appendix A. Inosine and L-

alanine+inosine samples were often smooth. It is unclear whether these features are cause by 

AFM tuning and humidity or because they have began to absorb water and expand, which 

would ‘stretch’ the outer spore coat. Alanine cells were the most curiously shaped cells of 

this study. They seemed to have very smooth plateau-like surfaces with bumpy deposits, as if 

they were smooth but ‘dirtied’. Their unusual surface structure and shape may be related to a 
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high amount of spore coat degradation and cell swelling without entering phase-1 

germination, as described in the following section. 

4.4. PHASE CONTRAST IMAGES 

Phase imagery provided more predictable results than the AFM imagery and analysis. 

Figures 9, 10, 11, and 12 show phase contrast images of the control, inosine, L-alanine, and 

L-alanine+inosine samples respectively. All four of these samples were prepared side-by-side 

and imaged within the same 30-minute period. 

 

FIGURE 9 – PHASE CONTRAST IMAGE, CONTROL 
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FIGURE 10 – PHASE CONTRAST IMAGE, INOSINE 

 

FIGURE 11 – PHASE CONTRAST IMAGE, L-ALANINE 
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FIGURE 12 – PHASE CONTRAST IMAGE, L-ALANINE+INOSINE 

The ‘germinated’ cells in the control sample are thought to be leftover cells from the 

sporulation/culturing process. During this process spores germinate, grow, and enter spore 

dormancy. If a spore does not undergo complete germination it could potentially withstand 

the washing process, which is completed to lyse fully vegetative cells. This theory is 

supported by this study’s results. If washing processes destroyed germinated spores, the 

spores would not show up in any of our samples. 

The inosine and L-alanine samples did not show a substantial increase in phase-dark cells 

over the control sample. These samples did not enter phase-1 germination, which 

corresponds to the activation of proteases and cortexlytic enzymes. The L-alanine+inosine 

sample entered phase-1 germination because the vast majority of these cells turned phase-

dark. 

The increase in size of the germinant samples over the control can be attributed to spore 

coat degradation by the enzymatic properties of L-alanine and inosine. Even with the high 

amount of swelling (spore coat degradation) in the L-alanine sample, exposure to only one 
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germinant was not enough to activate phase-1 germination. This is supported by the EA 

study by Ferencko as explained in section 2.1.3.  

It is unclear why the L-alanine sample showed much more growth than the L-

alanine+inosine sample. One might predict that more germinants would cause more 

enzymatic activity and spore coat degredation. It is clear that inosine causes less swelling in 

B. anthracis than L-alanine. It is therefore possible that inosine interferes with L-alanine at 

the cell’s receptor sites, where the degradation of the spore coat is triggered. 
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5. CONCLUSIONS AND RECOMMENDATIONS 
From the size and germination data obtained from the AFM and phase contrast images 

we can conclude that L-alanine and inosine at the studied conditions cause B. Anthracis 

spores to swell but do not enter phase-1 germination. Also, L-alanine in combination with 

inosine germinates B. Anthracis spores but causes less spore swelling than L-alanine alone. 

This may be caused by interference by inosine at spore receptor sites where L-alanine would 

otherwise have full access to degrade the spore coat. 

A quantitative roughness analysis of the spores was inconclusive because the AFM 

resolution was not detailed enough to capture the nano-scale structure changes associated 

with germination. At the recorded resolution, images and roughness were highly dependent 

on external factors such as humidity, tip tracking, and AFM tuning. 

The shape of spores was highly variable. Surface structures varied and included smooth, 

bumpy, and ridged features. Bumps and ridges on the spore surfaces became far less 

prevalent and prominent in samples exposed to germinants. 
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5.1. RECOMMENDATIONS 

A few things may be done to improve this study and further research on the processes of 

B. anthracis germination. 

THE AFM CONTROL SHOULD BE EXPOSED TO TRIS-HCL, INCUBATED, AND RE-IMAGED TO 

REDUCE VARIABILITY BETWEEN SAMPLES. 

A LARGER AFM SAMPLE OF L-ALANINE AND L-ALANINE+INOSINE SHOULD BE TAKEN. The 

most efficient way to obtain a large sample is to image dense populations of cells. Height 

data may not be obtainable using this method, but morphology comparison is accurate using 

only length and width data. 

IMAGE SPORES WITH A HIGH RESOLUTION TIP IN REAL TIME TO SEE HOW EACH CONDITION 

AFFECTS THE NANO-SCALE RODLET STRUCTURE. This study must be done in liquid, just as 

Plomp studied his Bacillus spores in 2007. Detailed images for each condition could reveal 

differences in mechanisms for each germinant. 
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APPENDIX A – CONTROL AFM IMAGES
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APPENDIX B – INOSINE AFM IMAGES
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Phase Image 
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Phase Image 
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APPENDIX C – L-ALANINE AFM IMAGES
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APPENDIX D – L-ALANINE+INOSINE AFM IMAGES
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Phase Image 
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Phase Image 
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This is another example of how imaging conditions can greatly affect the detail and 

quality of an image. 
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APPENDIX E – CELL GEOMETRY AND ROUGHNESS 

Sample 
Scan 
Area 

Image 
Number Length Width Area Height 

RMS 
Roughness 

Control 10 1 0.898 0.683 0.613 0.563  
Control 10 1 1.035 0.664 0.687 0.570  
Control 10 1 1.484 0.465 0.690 0.614 15.8 
Control 10 1 0.937 0.761 0.713 0.584  
Control 10 1 1.211 0.859 1.040 0.563  
Control 10 1 1.094 0.976 1.068 0.673 12.2 
Control 10 1 1.348 0.800 1.078 0.774 7.1 
Control 10 1 1.094 1.055 1.154 0.618 17.5 
Control 10 1 1.523 0.761 1.159 0.688  
Control 10 1 1.387 0.839 1.164 0.822 12.8 
Control 10 1 1.426 0.820 1.169 0.781 10.2 
Control 10 1 1.582 0.800 1.266 0.708 12.5 
Control 10 1 1.621 0.917 1.486 0.848 14.8 
Control 10 1 1.582 0.957 1.514 0.901 20.6 
Control 10 1 1.602 0.957 1.533 0.811 9.3 
Control 10 1 1.816 0.878 1.594 0.842 13.1 
Control 10 1 2.148 0.800 1.718 0.844 14.0 
Control 10 1 1.465 1.191 1.745 0.883  
Control 10 1 1.875 0.957 1.794 0.856 11.6 
Control 10 1 1.816 1.016 1.845 0.923 11.5 
Control 10 1 1.934 0.957 1.851 0.876  
Control 10 1 1.953 0.976 1.906 0.886 19.1 
Control 10 1 1.797 1.074 1.930 1.075  
Control 10 1 1.992 1.016 2.024 0.877  
Control 10 1 2.031 1.016 2.063 0.831 12.8 
Control 10 1 2.363 0.937 2.214 0.827 16.3 
Control 5 7 1.807 0.771 1.393 0.746 10.2 
Control 5 7 1.748 0.908 1.587 0.791 11.1 
Control 5 7 2.256 0.898 2.026 0.743 12.6 
Control 5 7 2.217 1.279 2.836 0.774 15.6 
Control 5 11 2.157 1.182 2.550 0.794 6.0 
Control 2.5 14 2.202 1.089 2.398 0.727 10.4 
Control 5 23 2.402 0.927 2.227 0.866 7.1 
Control 2.5 24 2.402 0.927 2.227  13.8 
Control 2.5 34 1.978 0.996 1.970  9.9 
Control 5 52 0.917 0.722 0.662 0.456 12.1 
Control 5 52 0.976 0.722 0.705 0.482 11.4 
Control 5 52 1.006 0.859 0.864 0.499 5.9 
Control 5 52 1.016 0.898 0.912 0.608 14.3 
Control 5 52 1.074 0.917 0.985 0.624 5.7 
Control 2.5 53 0.854 0.771 0.658 0.371 16.3 
Control 2.5 53 0.883 0.791 0.698 0.497 14.1 
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Sample 
Scan 
Area 

Image 
Number Length Width Area Height 

RMS 
Roughness 

Control 2.5 55 0.932 0.898 0.837 0.471 13.5 
Control 2.5 58 1.665 0.854 1.422 0.709 15.1 
Control 2.5 61 1.240 1.079 1.338 0.429 14.4 
Control 2.5 62 1.909 1.240 2.367 0.633 17.5 
Control 2.5 63 1.157 1.021 1.181 0.414 7.5 
Control 2.5 64 1.162 0.747 0.868 0.571 12.4 
Control 2.5 64 1.924 1.133 2.180 0.750 10.4 
Alanine 5 78 2.715 1.895 5.145 0.614 12.5 
Alanine 5 82 3.447 1.904 6.563 0.596 9.3 
Alanine 5 83 2.861 1.865 5.336 0.760 8.8 
Alanine 5 84 2.627 2.529 6.644 1.059 14.5 
Alanine 5 90 2.148 2.100 4.511 0.674 6.2 
Inosine 2.5 92 1.733 1.548 2.683 0.646 9.9 
Inosine 5 94 1.445 1.250 1.806 0.467 4.8 
Inosine 5 94 1.553 1.348 2.093 0.508 4.2 
Inosine 2.5 95 1.772 1.587 2.812 0.424 6.1 
Inosine 2.5 96 1.406 1.372 1.929 0.351 8.1 
Inosine 2.5 97 1.758 1.709 3.004 0.509 4.9 
Inosine 5 98 1.660 1.270 2.108 0.514 9.5 
Inosine 2.5 99 1.479 1.406 2.079 0.537 9.1 
Inosine 2.5 102 1.421 1.323 1.880 0.354 9.5 
Alan+Ino 2.5 103 2.070 1.514 3.134 0.298 7.7 
Alan+Ino 5 104 2.285 1.572 3.592 0.388 6.4 
Alan+Ino 5 106 1.563 1.240 1.938 0.349 6.8 
Alan+Ino 2.5 107 1.699 1.685 2.863 0.453 7.9 
Alan+Ino 5 108 2.285 1.270 2.902 0.400 6.2 
Alan+Ino 5 108 2.266 1.328 3.009 0.437 6.9 
Alan+Ino 5 108 2.969 1.387 4.118 0.367 5.8 
Alan+Ino 5 110 2.441 1.572 3.837 0.612 8.6 
Alan+Ino 2.5 112 1.655 0.942 1.559 0.518 7.3 
Inosine 5 114 1.172 0.996 1.167 0.491 6.7 
Inosine 5 114 1.211 1.006 1.218 0.572 8.2 
Inosine 5 114 1.270 0.966 1.227 0.605 6.5 
Inosine 5 114 1.357 0.927 1.258 0.585 6.8 
Inosine 5 114 1.211 1.074 1.301 0.498 6.0 
Inosine 5 114 1.299 1.104 1.434 0.570 7.2 
Inosine 5 114 1.377 1.104 1.520 0.485 6.6 
Inosine 5 114 1.279 1.230 1.573 0.552 7.2 
Inosine 5 114 1.377 1.260 1.735 0.535 8.6 
Inosine 5 114 1.465 1.367 2.003 0.495 6.7 

 


